
Welcome to Galaxy Software’s™ 

Galaxy of Win Games™
Click on an area of the Setup Browser to see a brief description of that

function.
Or, click on a topic in the Table of Contents below the image to see a

complete description.    

Note: while your browser may not look exactly like the one shown above, all functions will be the same.
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Introduction
Thank you for purchasing this Galaxy Software™ product.    This Browser will install any or all of the 
games contained on this CD.    Using the Browser is very simple.    There is a Program Listing in the 
main body of the Browser that contains buttons for each individual program.    Pass the mouse cursor 
over a button to view a brief description of that program in the Description Box at the bottom of the 
window.    If you choose to install the program, just click on the button.    

There are many other useful features in the browser for playing the games, visiting the Galaxy 
Software Website, upgrading certain games to their Premium Versions, and getting Technical Support. 

So explore this text and the Browser itself to learn all the features involved, and enjoy your new games.

Press the BACK button to return to the previous screen.



Installing a Program
To install any of the programs included on this CD, click on its button in the Program Listing.    
Installation will begin automatically, and the program will be installed to your hard drive.    There will be 
a short series of on-screen instructions to follow.    Most installations take less than a minute.    If you 
are not familiar with this type of installation program, just accept the default options.    

When the setup procedure is complete, you will be asked if you would like to read the Readme file.    
This file contains information on where to find the new program icons, and other useful information 
about the program.    

Once a program has been installed, clicking on its button again will automatically launch the program 
itself.    You do not, however, need this CD to run the program once it is installed. For convenience, 
there are program icons created in the Programs menu (via the START button on your desktop) which 
you can use to start the game.

Please note that clicking on a button will install that program ONLY.    You must click on each button to 
install each program separately.    

 
Press the BACK button to return to the previous screen.



Menu Bar Options
The Menu Bar is a standard Windows® menu bar.    Clicking on one of the items in the Menu Bar will 
display a list of options for that menu.    Click on a Menu Bar item below to see a complete list of 
options in that menu, and what functions they perform.

File 
Run 
Internet Wizard 
Favorites 
Tools 
Help 

Press the BACK button to return to the previous screen.



File Menu
The File menu consists of three options:

Exit-    Exits the Browser.
Open More Info-    Opens a local web page describing our main web sites.    You do not need to be 
connected to the internet to view this page.
Print More Info-    Prints the web page information on your PC’s printer.

Press the BACK button to return to the previous screen.



Run Menu
The Run menu is a listing of all the programs available on the CD.    It works the same way as clicking 
on a button in the Program Listing .    If the program is not yet installed, it will install it for you. If it is 
installed, it will run the game.    

Press the BACK button to return to the previous screen.



Internet Wizard
 

This is the Internet Wizard button on the Menu Bar.    The Internet Wizard will connect you to the 
Internet using your Internet Service Provider (ISP) or network.    You must have a valid, operating 
account with an ISP, or be on a network that has access to the internet to visit any of the web sites 
listed in this program. 

When you first click on any of the web links, you will be prompted to make sure you connected to the 
internet via your ISP.

Click on Yes if you are already connected.
Click on No if you are not connected and do not want to connect at the present time.
Click Start Internet Wizard if you are not connect, but would like to connect at this time.

For more information on connecting, click on the option below that applies to you.

Internet Service Provider (via your computer  ’  s modem)   
Network 

Press the BACK button to return to the previous screen.



Using the Internet Wizard with an Internet Service Provider (ISP)
Clicking on the Internet Wizard menu item will bring up the Internet Wizard:

This dialogue window will consist of a list of possible ISP’s to connect to from your computer (for most 
users, there will only be one- you should recognize the name).

Highlight the ISP connection you wish to use, then click on the Connect button to begin the dial up 
connection.    You will be prompted to connect to your ISP just as if you were connecting to the internet 
or your email program.    You may need to input your ISP password.

If you have America Online®, it will start the America Online program.    Simply connect as you normally
would, and once connected, just minimize the AOL program (by clicking on the “_” box on the upper 
right hand corner of the window).    

Once you are connected, you can return to the Galaxy Browser by clicking on the Return button on the
small window at the top of the screen.

Once you return to the Browser, you can then select any of the web links located in the Button Bar, 
Favorites Menu, or Help Menu.    

*Please Note: This Browser works best with Microsoft® Internet Explorer® 4.0, Netscape® Navigator®
4.0, or America Online® 4.0.    Older versions of these browsers or other third party browsers may not 
be compatible with this program.

Press the BACK button to return to the previous screen.



Connecting via a Network
If your computer is connected to a network, and you wish to go to our web site, your network must 
have internet access.    See your Systems Administrator if your are unsure.    
If you do have internet access via your network, you should not have to use the Internet Wizard.    If 
you do use the Wizard, then you will be prompted with the same Internet Wizard dialogue window as if 
connecting to an ISP.    However, the wizard will have a message in it that says detect a Dial Up 
Connection.    This is normal.    Simply click on the Connect button.    

Press the BACK button to return to the previous screen.



Favorites Menu
The Favorites Menu consists of the best of Galaxy Software, plus a place to store all of your favorite 
Galaxy Software programs.    It consists of the following items:

My Favorites-    Displays a list of your favorite Galaxy Software Programs.    You can add any of the 
programs on this CD to this menu by clicking the right mouse button on the button of the game you 
wish to add, then selecting the Add to Favorites item from the resulting menu. 

Make Galaxy Your Home Page-    This item will make the Galaxy Software web site your home page 
whenever you start your internet browser.

Create Desktop Shortcut to Website-    This item will create a shortcut to our web site on your 
desktop.    Clicking on this shortcut will automatically launch your internet browser (you must be 
connected to your ISP first) and go directly to the Galaxy Software web site.    

Galaxy Software Store-    Goes to Galaxy Software’s online shopping site, where you can purchase 
any of our the programs we offer in our extensive catalogue.    

Free Galaxy Games-    This item goes to our Galaxy Gamers Club site.    Being a member of the club 
entitles you to free demos of our software, usually before they are available at retail.

Galaxy Clipart Website-    This item goes to our Galaxy Clip Art website.    At this site you will find 
thousands of images for purchase and download for your multimedia projects.

Galaxy Technical Support-    This item will go directly to our Technical Support Page.    If you have any
questions about this browser or any of the games it contains, and cannot find the answers in this help 
text, click on this item to get support online.    

* Please Note:    In order to go to any of the web sites in this menu, you must be connected to your 
Internet Service Provider (ISP) first.    See the section on the Internet Wizard for instructions on how to 
connect.      

Press the BACK button to return to the previous screen.



Right Click Menu
This is the right click menu.    To add an option to your favorites list, click on Add to Favorites.

Press the BACK button to return to the previous screen.



Tools Menu
This menu contains several tools that are standard in Windows®.    If you need to reconfigure your 
system, or provide technical information to our technical support representatives, these items can help.

System Info-    Displays vital information about your computer and its hardware.    This information may
be very useful if you experience problems, and need technical support from our Technical Support 
Center.    

Display Info-    This item displays information about your computer’s display options, such as the 
resolution and color depth, should you need to change them.    If you have problems seeing colors, 
etc., see the Troubleshooting section for help.

Find Files-    This will bring up the standard Windows Find Files dialogue box.    It may be useful if you 
need technical support and are asked to find a file.
 
Windows Explorer-    Brings up the Window Explorer, a file management utility that is standard in 
Windows® 95/98.

Options-    This will bring up the options dialogue.    This dialogue contains a check box stop running 
the introduction video if you desire.

Press the BACK button to return to the previous screen.



Help Menu
This Help Menu is filled with options to help you understand how to use the browser better.    While the 
basic functions are very simple to use, you may not be familiar with all options.    This menu consists of 
the following items for your convenience:

Register…-    This option will go to our web site, where you can electronically register your new galaxy 
Software product.    Registration entitles you to many options and services.    Please see our web site 
for information about registering.
    
Email Tech Support-    This item will call your internet email client and start a new message, already 
addressed to tech@romt.com.    You may then type in the problem you are having, and email your 
question directly to our technical support representatives    (Note- you must have an existing email 
account with an ISP to use this function, and your email client must be registered as the default email 
client on your computer.    If you get the Internet Mail Configuration Setup Wizard, or a message 
saying that no email client is set up, you do not have an email client registered on your computer, even 
though you may use email).

Web Help-    This item will take you directly to our Technical Support Web page, where you can view 
Frequently Asked Questions, or submit an online technical request form.    (Note: you must be 
connected to your ISP before connecting).

About…-    Displays information about this program, such as the version number.
          

Press the BACK button to return to the previous screen.



The Button Bar

This is the Button Bar.    Simply left click on any of the buttons to access that particular function.    The 
following is a description of each button:

Help-    Clicking this button will bring up this help text document.    

Visit Us On the Web-    Clicking this button will go to our main web site.    To view some of our other web 
sites, check out the Favorites menu.    You must be connected to your Internet Service Provider before 
you can go to any of our web sites.    See the section on the Internet Wizard to find out how to connect.

Premium Info-    Many of the programs on this CD have “Premium Editions”.    Premium additions are 
special versions of the software that are sold separately.    They have additional levels, special 
functions, and many more features.    If you particularly like a certain game on this disk, you may 
purchase the Premium Edition if you desire.    Press the Premium Info Button for more information.    

Press the BACK button to return to the previous screen.



The Program Listing
The Program Listing is the main body of the Browser. It consists of a button for each game contained 
on the CD.      There are several functions you can perform using these buttons.    

The main function of the buttons is to install the program.    When you hover your mouse cursor over a 
button, it will display a brief description of that game in the description box on the bottom of the 
window.    

If you would like to install the game, simply click on the button with the left mouse button.    This will 
launch the installation program for that game.    The installation program will show a series of screens 
allowing you to change some of the options.    If you are unfamiliar with this type of installation program,
you should simply accept all of the default options.    The program will be installed on your hard drive 
automatically.    

Once the program has been installed, the button for this game in the Program Listing will now start the 
program.    You do not, however, need to use this CD to use a program once it has been installed.    All 
of the programs on this CD will be installed to your hard drive.    When the installation program is 
finished, it will ask you to view a text file, which will tell you how to start the program.    For more 
information, see Installing a Program .

There are several other functions for these buttons.    Clicking the right mouse button on a button will 
bring up another menu.    This menu will offer the following options:

Run- This item will start the program.

Setup- This item will start the installation program again, should you require to run it once the program 
is installed. 

Uninstall- Only available after a program has been installed. See the Uninstalling a Program section 
for more information.

Add to Favorites- This item will add this program to the Favorites menu. 

There is a scroll bar on the right side of the Program Listing.    Use this scroll bar to scroll up and down 
the list of buttons if they are not all visible on the screen.

Press the BACK button to return to the previous screen.



Contacting Galaxy Software
RomTech, Inc. 1-215-750-6606
2000 Cabot Boulevard West 1-215-750-3722 (FAX)
Suite 110 M-F 8:30AM-5:00PM EST
Langhorne, PA    19047 Website: http://www.romt.com

Ordering Information
To view our catalogue of exciting full feature games, visit our website at http://www.romt.com. Be sure to stop by the Order page. 
From action-packed games to Home Office Help to Clip Art, we have something for everyone.    Our catalogue is growing every 
day, so be sure to check it out often!

If you would like to email your order to us, please send it to orders@romt.com. Please include credit card information, including 
expiration date.

To place an order for any product over the phone, call: 
1-215-750-6606
M-F 8:30AM-5:00PM EST

Registration Information
You may register your Galaxy Software product via our website at http://www.romt.com, or fill out the enclosed registration card 
and mail it to the address above, or fax it to 1-800-355-8597.

Customer Support
The answers to most commonly asked questions can be found on our website at http://www.romt.com, in the Tech Support page.
Be sure to check out the Frequently Asked Questions (FAQ) page.    If you cannot find the answer to your question, there is an 
online Technical Support request form to submit your question.    

If you would like to email your question to a Technical Support representative, you can email it to tech@romt.com.    Be sure to 
mention the following:

1. Name of product
2. Exact error reported (if any) & a description
3. Computer's processor type and speed (i.e. Pentium II 333, etc.)
4. Any other relevant hardware information (i.e. the amount of RAM, type of Video Card, etc.)

If you need to speak to a Technical Support representative in person, please call:
1-215-750-6606
M-F 8:30AM-5:00PM EST

Press the BACK button to return to the previous screen.



Uninstalling a Program
Uninstalling a program is now remarkably easy with the Galaxy Browser.    Simply click the right mouse 
button on the button of the game you want to uninstall in the Program Listing, and select the uninstall 
option from the resulting menu.    The game will be automatically uninstalled for you.

You can also uninstall these programs without the Browser, just as you would most other Windows 
programs.

Click on the Start button, then select the “Settings” menu, and then click on the Control Panel icon as
highlighted below.

In the Control Panel window, double click on the 
Add/Remove Programs applet.

In the Add/Remove Programs Properties window, highlight the program you wish to uninstall, then click
the Add/Remove… button.



Click YES when prompted if you really want to uninstall the program, and it will automatically be 
uninstalled.

NOTE:    Some programs create small files after they have been installed, to keep high scores for 
example.    These files might not be uninstalled, and you will receive a message saying that not all files 
were removed if that is the case.    You can uninstall these files manually if you wish, but usually they are 
well under 1 kb in size, and of no consequence to hard drive space.    It is perfectly safe to leave these 
files where they are.

Press the BACK button to return to the previous screen.



Troubleshooting

This is a list of some commonly asked questions about the Galaxy Browser.    For additional help or 
information, please visit the Tech Center web site via the “Web Help” item in the Help menu.

For help on a particular game contained on this CD, please refer to the instructions for that game.

Question:    When running the Galaxy Browser, colors seem distorted, or “flash” oddly when using 
other windows on the screen.

Answer:    The Galaxy Browser is optimized for 16 bit color displays, which provide superior visual quality.
Odd color flashes will occur if your Display Settings are set for 256 color.    

To change your color settings, simply click on the Help menu, then the “Display Info” item.    This will 
bring up the Windows Display Properties dialogue.    Click on the “Settings” tab if it is not already 
displayed.

In the “Colors” section, click on the down arrow to view the pull down menu.    Select the “High Color 
(16 bit)” item from this list, then click the OK button.    It will display a “Compatibility Warning” window, 
asking you if you would like to restart Windows.    It is recommended that you restart Windows after 
changing these settings.    To do so, check off “Restart your Computer”.    Be sure to save all open 
files before clicking OK.

Question:    I do not have Autorun enabled on my computer.    Is there an easier way to start the 
program every time?

Answer#1:    If you wish, you can enable Autorun on your computer.    To do so, click the right mouse 
button on the My Computer icon on your desktop, then click on Properties to display the System 
Properties dialog box.    Click on the Device Manager tab. Click the plus sign next to CDROM, 
highlight the specific CR ROM drive you want to change, and then click Properties. Click the Settings
tab. Select the Auto insert notification check box.    Autorun is now enabled.
 
Answer#2:    If you do not want Autorun enabled, you may create a shortcut on your desktop for the 
program.    To do so, click the right mouse button on an empty space on the desktop.    Select the New 
menu item and then select Shortcut.    In the Create Shortcut dialogue window, type “d:\setup.exe” in 
the command line (where “d” represents the letter of your CD ROM drive.    You must know the correct
letter for this shortcut to work properly.    To find out which letter is your CD drive, double click the “My 
Computer” icon.    The drive depicting a circular CD is your disk drive.    Use this letter).    Then click the
Next button.    Type in “Galaxy of Games 1” as the name of the shortcut, then click Finish.    The icon 
will be created on your desktop.    Now, to start the program, just insert the CD into the CD ROM drive 
and double-click this icon.

Question:    The Browser looks distorted- buttons are cut off, pictures and logos are incomplete or at 
odd places, and the Browser looks generally disordered.    How do I fix this?

Answer:  This is due to an incompatibility with some older video cards in higher screen resolutions.    
To correct this problem, you need to change your screen resolution, then change it back to the way 
you like it.    In the Menu bar, click on the Tools menu, then click on the Display Info item.    In the 



Display Properties dialogue window, click on the Settings tab.    In the Screen area section, drag the 
slider to the far left, to “640x480 pixels”.    Click the Apply button and click OK.    When prompted if 
you want to keep this setting, click Yes.  View the Galaxy Browser again.    It should look complete.    
If you do not want to keep this display setting, simply drag the slider in the Display Properties dialogue
window back to the screen resolution you would like, then click OK.    The Browser should still be 
displayed correctly.      

Question:    When I run certain games, they appear frozen (unresponsive); at least there is no mouse 
pointer visible, or the mouse pointer flashes and flickers.    What’s wrong?    

Answer:    The problem usually has to do with the mouse pointer settings.    Try this test.    Click on the 
Start button on the bottom left corner of the desktop, select Settings, then click Control Panel.    
Double click on the “Mouse” icon, then select the “Pointers” tab.    In the “Scheme” pull down menu at
the top, click on the arrow to pull down the menu, then select “None” and click OK.    Start the game 
that had the problem again.    The mouse pointer should be in view.

Question:    How do I install a program on this CD to my Hard Drive?

Answer:    See the section on Installing a Program.

Question:    How do I run a program once it is installed, and/or do I need this CD once the game is 
installed?

Answer:    See the section on the Program Listing.

Question:    How do I remove a program from my hard drive if I do not want it anymore?

Answer:    See the section on Uninstalling a Program. 

Question:    I love a particular game(s) on the CD.    Is there any way to find out if there is a more 
advanced level of the game?

Answer:    Click on the Premium Info button on the button bar of the browser for more information on 
Premium Versions of our software. 

Press the BACK button to return to the previous screen.



Title
This is the title of this particular CD-ROM.
 



Galaxy Logo
This is the Galaxy Software logo. 



Help Button
This is the Help Button.    Clicking this button will display this help text.



Web Button
This is the button for Galaxy Software  ’  s Website  .    Click on this button to start your web 
browser and go to the Galaxy Software website.



Premium Info Button
This is the Premium Information button.    Click on this button to get information on the 
Premium Editions of many of the programs on this CD.



Program Listing
This is the list of programs included on this CD.    Each picture is a button.    Just click on the 
button of the program you want to install.    The installation application for that program will 
start automatically.    Just follow the on screen instructions and the game will be installed to 
your hard drive.
 



Description Box
This box will display a short description of each game while the mouse cursor is over its 
button.    It will also give a description of the other buttons and functions of the browser.



Scroll Bar
This is a standard Windows® scroll bar.    Click the up arrow at the top to scroll up.    Click 
the down arrow at the bottom to scroll down.    



Menu Bar
This is the Menu Bar.    Clicking on one of the topics will produce a pull down menu with 
other options.    See the section on the Menu Bar Options for a complete list of features.    
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